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Chapter 242

Tests for Two Proportions
in a Stratified ClusterRandomized Design
(Cochran-Mantel-Haenszel
Test)
Introduction
This procedure calculates power and sample size for tests for two proportions in a stratified cluster randomized
design in which the outcome variable is binary. It uses the results of Xu, Zhu, and Ahn (2019) which extends
previous results to include varying cluster size. Although response rates may vary among strata, hypotheses about
the overall odds ratio are tested with the Cochran-Mantel-Haenszel test.

Technical Details
The following discussion summarizes the results in Xu, Zhu, and Ahn (2019).
Suppose you are interested in comparing the disease response rates of two groups (treatment and control). Further
suppose that response rate is known to be related to other covariates (such as age, race, or gender). It is often
desirable to remove the covariate’s impact from the comparison of the two proportions. This is accomplished by
stratifying on the covariates and forming hypotheses about a common odds ratio across all clusters and strata. It is
assumed that the data will be analyzed using the Cochran-Mantel-Haenszel test.
In this design, assume that the randomization is balanced with an equal number of clusters assigned to each of the
two groups. We denote the treatment group as group 1 and the control group as group 2. Denote the number of
clusters in each of the two groups in stratum k by Jk. The number of strata is denoted as K.
Let the cluster sizes be denoted by 𝑛𝑛1𝑗𝑗𝑗𝑗 and 𝑛𝑛2𝑗𝑗𝑗𝑗 where j is the cluster in stratum k. It is assumed that these cluster
sizes are independently and identically distributed with means 𝜇𝜇𝑘𝑘 and standard deviations 𝜏𝜏𝑘𝑘 , 𝑘𝑘 = 1, … , 𝐾𝐾. The
𝐽𝐽𝑘𝑘
total number of subjects in the study is 𝑁𝑁 = ∑𝐾𝐾
𝑘𝑘=1 ∑𝑗𝑗=1�𝑛𝑛1𝑗𝑗𝑗𝑗 + 𝑛𝑛2𝑗𝑗𝑗𝑗 �.
Let 𝑌𝑌1𝑖𝑖𝑖𝑖𝑖𝑖 and 𝑌𝑌2𝑖𝑖𝑖𝑖𝑖𝑖 be the binary outcome variable with possible values 0 or 1. Let 𝜋𝜋1𝑘𝑘 and 𝜋𝜋2𝑘𝑘 be the
corresponding response probabilities for these variables in the treatment and control groups of the kth stratum. Let
𝑛𝑛1𝑗𝑗𝑗𝑗
𝑛𝑛1𝑗𝑗𝑗𝑗
𝐽𝐽𝑘𝑘
𝐽𝐽𝑘𝑘
𝐽𝐽𝑘𝑘
𝐽𝐽𝑘𝑘
∑𝑖𝑖=1
∑𝑖𝑖=1
𝑝𝑝1𝑘𝑘 = �∑𝑗𝑗=1
𝑌𝑌1𝑖𝑖𝑖𝑖𝑖𝑖 � / �∑𝑗𝑗=1
𝑛𝑛1𝑗𝑗𝑗𝑗 � and 𝑝𝑝2𝑘𝑘 = �∑𝑗𝑗=1
𝑌𝑌2𝑖𝑖𝑖𝑖𝑖𝑖 � / �∑𝑗𝑗=1
𝑛𝑛2𝑗𝑗𝑗𝑗 � be the corresponding
estimates of 𝜋𝜋1𝑘𝑘 and 𝜋𝜋2𝑘𝑘 .
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Let 𝜌𝜌 be the intracluster correlation coefficient (ICC) which is a measure of the similarity of subjects within the
same cluster. Note that this correlation is assumed to be constant across all clusters.
Define the odds ratio between the treatment and control groups as
𝜋𝜋1𝑘𝑘
1 − 𝜋𝜋1𝑘𝑘 𝜋𝜋1𝑘𝑘 (1 − 𝜋𝜋2𝑘𝑘 )
=
𝜓𝜓𝑘𝑘 = 𝜋𝜋
2𝑘𝑘
𝜋𝜋2𝑘𝑘 (1 − 𝜋𝜋1𝑘𝑘 )
1 − 𝜋𝜋2𝑘𝑘
Further let 𝜓𝜓 denote common odds ratio.

The task is to estimate the number of clusters needed for testing 𝐻𝐻0: 𝜓𝜓 = 1 versus 𝐻𝐻1: 𝜓𝜓 ≠ 1 for a two-sided
significance level 𝛼𝛼 and a power of 1 − 𝛽𝛽.

The Cochran-Mantel-Haenszel statistic for testing the above hypothesis is
𝐶𝐶 =
where

∑𝐾𝐾
𝑘𝑘=1 𝑤𝑤𝑘𝑘 (𝑝𝑝1𝑘𝑘 − 𝑝𝑝2𝑘𝑘 )

2
�∑𝐾𝐾
𝑘𝑘=1 𝑤𝑤𝑘𝑘 [Var(𝑝𝑝1𝑘𝑘 ) + Var(𝑝𝑝2𝑘𝑘 )]

𝑤𝑤𝑘𝑘 =

𝑛𝑛1𝑘𝑘 𝑛𝑛2𝑘𝑘
𝑛𝑛1𝑘𝑘 +𝑛𝑛2𝑘𝑘
𝐽𝐽𝑘𝑘

𝑛𝑛1𝑘𝑘 = �

𝑗𝑗=1

𝐽𝐽𝑘𝑘

𝑛𝑛2𝑘𝑘 = �

𝑗𝑗=1

𝑛𝑛1𝑗𝑗𝑗𝑗

𝑛𝑛2𝑗𝑗𝑗𝑗

The distribution of the statistic C is asymptotically standard normal.

Power Calculations
The following formulas for power use the quantities T, U, and V which are defined as follows
𝐾𝐾

𝜏𝜏𝑘𝑘2
1
𝑇𝑇 = � � 𝑓𝑓𝑘𝑘 �𝜌𝜌𝜇𝜇𝑘𝑘 + 𝜌𝜌 + (1 − 𝜌𝜌)� 𝜋𝜋�𝑘𝑘 (1 − 𝜋𝜋�𝑘𝑘 )
𝜇𝜇𝑘𝑘
2
𝑘𝑘=1
𝐾𝐾

𝜏𝜏𝑘𝑘2
1
𝑈𝑈 = � � 𝑓𝑓𝑘𝑘 �𝜌𝜌𝜇𝜇𝑘𝑘 + 𝜌𝜌 + (1 − 𝜌𝜌)� [𝜋𝜋1𝑘𝑘 (1 − 𝜋𝜋1𝑘𝑘 ) + 𝜋𝜋2𝑘𝑘 (1 − 𝜋𝜋2𝑘𝑘 )]
𝜇𝜇𝑘𝑘
8
𝑘𝑘=1

𝐾𝐾

1
𝑉𝑉 = � 𝑓𝑓𝑘𝑘 (𝜋𝜋1𝑘𝑘 − 𝜋𝜋2𝐾𝐾 )
4
𝑘𝑘=1

𝜋𝜋�𝑘𝑘 = (𝜋𝜋1𝑘𝑘 + 𝜋𝜋2𝐾𝐾 )/2

𝑓𝑓𝑘𝑘 = (𝑛𝑛1𝑘𝑘 + 𝑛𝑛2𝑘𝑘 )/𝑁𝑁

𝜋𝜋1𝑘𝑘 =

𝜓𝜓𝜋𝜋2𝑘𝑘
1 − 𝜋𝜋2𝑘𝑘 + 𝜓𝜓𝜋𝜋2𝑘𝑘
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Three cases of statistical hypotheses are available. The power formula for each case is
1. 𝐻𝐻0: 𝜓𝜓 ≥ 1 versus 𝐻𝐻1: 𝜓𝜓 < 1.
Power = 1 − 𝛽𝛽 = 1 − Φ �

𝑉𝑉√𝑁𝑁 − 𝑇𝑇𝑧𝑧𝛼𝛼
�
𝑈𝑈

Power = 1 − 𝛽𝛽 = 1 − Φ �

−𝑉𝑉√𝑁𝑁 + 𝑇𝑇𝑧𝑧1−𝛼𝛼
�
𝑈𝑈

Power = 1 − 𝛽𝛽 = 2 − Φ �

𝑉𝑉√𝑁𝑁 − 𝑇𝑇𝑧𝑧𝛼𝛼/2
−𝑉𝑉√𝑁𝑁 + 𝑇𝑇𝑧𝑧1−𝛼𝛼/2
�− Φ�
�
𝑈𝑈
𝑈𝑈

2. 𝐻𝐻0: 𝜓𝜓 ≤ 1 versus 𝐻𝐻1: 𝜓𝜓 > 1.
3. 𝐻𝐻0: 𝜓𝜓 = 1 versus 𝐻𝐻1: 𝜓𝜓 ≠ 1.

where Φ(𝑥𝑥) is the standard normal cumulative distribution function.

These power formulas are used to conduct a binary search for sample size or odds ratio.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, refer to the Procedure Window chapter.

Design Tab
The Design tab contain most of the parameters and options of interest for this procedure.

Solve For
Solve For
This option specifies the parameter to be solved for using the other parameters. The parameters that may be
selected are OR, Power, or Sample Size. Select Sample Size when you want to calculate the sample size needed to
achieve a given power and alpha level. Select Power when you want to calculate the power.

Test
Alternative Hypothesis
This option specifies whether a one-sided or two-sided hypothesis is analyzed.
One-Sided (H1: OR < 1) refers to a one-sided test in which the alternative hypothesis is of the form
H1: OR < 1.
One-Sided (H1: OR > 1) refers to a one-sided test in which the alternative hypothesis is of the form
H1: OR > 1.
Two- Sided (H1: OR ≠ 1) refers to a two-sided test in which the alternative hypothesis is of the form H1: OR ≠ 1.
Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the
hypothesis test. Its accuracy is critical.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal proportions when in fact they are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal
group proportions when, in fact, they are equal.
Values must be between zero and one. Historically, an alpha value of 0.05 has been recommended for two-sided
tests and 0.025 for one-sided tests. You should pick a value for alpha that represents the risk of a type-I error you
are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Sample Size)
Enter one or more values of N, the total number of subjects in the study. This parameter is the sum of the subjects
in all clusters or strata. It is assumed that the number of treatment and control subjects is balanced in each stratum.
The N subjects are divided among the strata using the 'Percent of N in Each Stratum' setting.
Example
Suppose that N is 1000 and three strata are used with 'Percent of N in Each Stratum' set to 25, 25, 50. The three
stratum sample sizes would be 250, 250, and 500.
The number of clusters is based on this number and the 'Average of Cluster Sizes' settings.

Effect Size
OR (Actual Odds Ratio)
Specify the odds ratio at which the power is to be calculated. The difference between this value and one represents
the magnitude of the effect you wish to detect. This value is used with Pr(Success) in the Control Group (P2) to
calculate the Pr(Success) in the treatment (intervention) group.
You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25.
The odds ratios must be greater than 0 and unequal to 1. Commonly, the odds ratio is between 0.25 and 4.0.
ICC (Intracluster Correlation)
Enter a value for ICC, the intracluster correlation coefficient. This may be thought of as the correlation between
any two observations in the same cluster. Xu, Zhu, and Ahn (2019) suggested estimating this parameter separately
for each stratum-group and then averages these values to obtain a final estimate. They also mention obtaining
confidence intervals for ICC from pilot (or previous) data.
Note that occasionally, ICC < 0. Since this is a correlation coefficient, it is possible for it to range from -1 to 1.
You may enter a single value or a list of values, such as 0.01 0.02 0.03.
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Strata Information
Cluster Size Variation Input
There are two ways in which you can specify the variation of the cluster sizes within a stratum. These are
•

Standard Deviation
You will need to enter the population standard deviation of the cluster sizes within each stratum.

•

Coefficient of Variation
You will need to enter the population coefficient of variation of the cluster sizes within each stratum.

Set
This is an identification number used on the reports.
Number of Strata
Specify the number of strata specified on this line. Usually, you will enter a “1” to specify a single stratum, or you
will enter a “0” to ignore this line. However, this option lets you specify several strata that have the same
parameter values.
The total number of strata is equal to the sum of these values.
Examples
0 which means ‘ignore this line’.
1 which means ‘one stratum defined by this line’.
2 which means ‘two strata defined by this line’.
Percent of N in Each Stratum
Enter the percentage that the number of subjects in a stratum is of the total number of subjects. If this line defines
more than one stratum, this is the percentage FOR EACH stratum.
These percentages must sum to 100. If they don't, the program will adjust them so they do.
For example, suppose you enter two sets and specify a Number of Strata for both sets of 5. Further suppose that
you enter 25 for the Percent of N in Each Stratum in both sets. The program would realize that there is a total of
10 strata in the experiment with an equal percentage of the total in each stratum. Thus, the individual percentages
would be adjusted from 25 to 10.
Note that you should only enter one number, even if there are more than one stratum being defined by the line.
These values can be any positive values. The values will be adjusted so that the percentages sum to 100.
Average of Cluster Sizes
Enter the average cluster size of the clusters in a stratum in this set. This number applies to clusters in both the
treatment and the control groups.
The value must be greater than or equal to 1.
Standard Deviation of Cluster Sizes
Enter the population standard deviation of the cluster sizes in this set. This number applies to both the treatment
and the control groups.
The values must be than or equal to zero.
Example
Suppose the five cluster sizes in a stratum are 225, 314, 197, 266, and 248. The average cluster size is 250 and the
population standard deviation (using N = 5 in the denominator) is 39.4715.
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Coefficient of Variation of Cluster Sizes
Enter the coefficient of variation of the cluster sizes in this set. This number will apply to both the treatment and
the control groups.
Coefficient of Variation (CV)
The coefficient of variation used here is the population standard deviation divided by the mean. It is used to
calculate the standard deviation of the cluster sizes. It is often used because the standard deviation of cluster sizes
is often roughly proportional to the cluster size mean.
The values must be greater than zero.
Pr(Success) in the Control Group (P2)
This is the probability that outcome of a subject in the CONTROL group in a stratum defined on this line will be
positive (equal to one). In this procedure, it is labelled P2.
The success probability in the treatment group is calculated from this value using the common odds ratio. The
relationship within a stratum is
OR = Odds(P1)/Odds(P2)
which, solving for P1, gives
P1 = (OR)P2 / (1 - P2 + (OR)P2).
Since this is a proportion, it must be between 0 and 1.
Show More Strata Sets
Check this box to show ten more Strata Information sets.
If this option is not checked, any active strata sets (Number of Strata > 0) with set identification numbers > 5 will
be ignored.
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Example 1 – Finding Sample Size
A study is being planned to investigate the possible association between a certain drug and a certain disease. Since
age is known to affect the disease rates, the population is stratified into four age groups with weights of 10%,
40%, 35%, and 15%. Furthermore, patients will be clustered by clinics. All patients in a clinic will receive either
an intervention drug or a standard drug. The number of clinics receiving each treatment will be balanced.
Prior studies had shown the probability of this disease continuing after receiving the baseline treatment was 0.25,
0.20, 0.15, and 0.10, respectively, among the four age groups. The average number of patients per clinic has
historically been 30, with a coefficient of variation of 0.4.
Two values of ICC will be used: 0.015 and 0.1. The significance level is set to 0.05 and the power is set to 0.8.
The odds ratio is set to 1.5, 2, and 3.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load this procedure. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For .................................................................. Sample Size
Alternative Hypothesis .............................................. Two-Sided (H1: OR ≠ 1)
Power ........................................................................ 0.8
Alpha ......................................................................... 0.05
OR (Actual Odds Ratio) ............................................ 1.5 2 3
ICC (Intracluster Correlation) .................................... 0.015 0.1
Cluster Size Variation Input ...................................... Coefficient of Variation
Set 1 Number of Strata ............................................. 1
Set 1 Percent of N in Each Stratum .......................... 10
Set 1 Average of Cluster Sizes ................................. 30
Set 1 Coefficient of Variation of Cluster Sizes .......... 0.4
Set 1 Pr(Success) in the Control Group (P2) ........... 0.25
Set 2 Number of Strata ............................................. 1
Set 2 Percent of N in Each Stratum .......................... 40
Set 2 Average of Cluster Sizes ................................. 30
Set 2 Coefficient of Variation of Cluster Sizes .......... 0.4
Set 2 Pr(Success) in the Control Group (P2) ........... 0.2
Set 3 Number of Strata ............................................. 1
Set 3 Percent of N in Each Stratum .......................... 35
Set 3 Average of Cluster Sizes ................................. 30
Set 3 Coefficient of Variation of Cluster Sizes .......... 0.4
Set 3 Pr(Success) in the Control Group (P2) ........... 0.15

242-7
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for Two Proportions in a Stratified Cluster-Randomized Design (Cochran-Mantel-Haenszel Test)
Set 4 Number of Strata ............................................. 1
Set 4 Percent of N in Each Stratum .......................... 15
Set 4 Average of Cluster Sizes ................................. 30
Set 4 Coefficient of Variation of Cluster Sizes .......... 0.4
Set 4 Pr(Success) in the Control Group (P2) ........... 0.1
Set 5 Number of Strata ............................................. 0
Show More Strata Sets ............................................. Unchecked

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results of the Cochran-Mantel-Haenszel Test ───────────────────────────────────
Hypotheses:
H0: OR = 1 vs. H1: OR ≠ 1
Number of Strata:
4

Power
0.8000
0.8000
0.8000
0.8000
0.8000
0.8000

Total
Sample
Size
N
1815
5275
578
1681
212
617

Anticipated
Treatment
Number of
Actual Probability
Clusters Odds Ratio of Success
M
OR
P1
60.0
1.5000
0.2371
176.0
1.5000
0.2371
20.0
2.0000
0.2919
56.0
2.0000
0.2919
7.0
3.0000
0.3801
20.0
3.0000
0.3801

Control
Probability
of Success
P2
0.1725
0.1725
0.1725
0.1725
0.1725
0.1725

Intracluster
Correlation
Coefficent
ICC
0.0150
0.1000
0.0150
0.1000
0.0150
0.1000

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
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Statistic,' Biometrics, Volume 42, pages 927-932.
Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the total sample size, i.e., the total number of subjects summed across all strata.
M is the anticipated number of clusters. Half of these clusters are assigned to the treatment group, while the other
half are assigned to the control group.
OR is the overall odds ratio, [Odds1] / [Odds2] assumed by the alternative hypothesis. This is the OR at which the
power is computed.
P1 is the probability of a success in the treatment group. This is the weighted average of the individual P1's of all
strata.
P2 is the probability of a success in the control group. This is the weighted average of the individual P2's of all
strata.
ICC is the intracluster correlation coefficient. This is the correlation between any two responses within a particular
stratum.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements ─────────────────────────────────────────────────────────
A stratified design, which divides the sample among 4 strata, is analyzed using the two-sided,
Cochran-Mantel-Haenszel test. The total sample size of 1815 subjects, which is obtained from 60.0 clusters,
achieves 80% power to reject an odds ratio of one assumed by the null hypothesis when the odds ratio is actually
1.5000. The significance level of the test was set at 0.050. Note that each cluster was completely allocated to
either the treatment or control and that the number of treatment and control clusters was balanced within each
stratum.
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Strata-Detail Report
Strata-Detail Report ──────────────────────────────────────────────────────────

Set
1
2
3
4

Number
of Strata
1
1
1
1

Percent of
N in Each
Stratum
10.00
40.00
35.00
15.00

Average
of Cluster
Sizes
30.0
30.0
30.0
30.0

Standard
Deviation
of Cluster
Sizes
12.00
12.00
12.00
12.00

Coefficient
Pr(Success)
of Variation in the Control
of Cluster
Group
Sizes
P2
0.4000
0.2500
0.4000
0.2000
0.4000
0.1500
0.4000
0.1000

Strata-Detail Report Definitions
Set is an identification number on the input screen.
Number of Strata is the number of strata defined by this set (input line).
Percent of N in Each Stratum is the percentage of the total sample size that is allocated to each stratum in this
set.
Average of Cluster Sizes is the average cluster size (number of subjects) in each stratum of this set.
Standard Deviation of Cluster Sizes is the standard deviation of the cluster sizes in each stratum of this set.
Coefficient of Variation of Cluster Sizes is the coefficient of variation (SD/Mean) of the cluster sizes in each
stratum of this set.
Pr(Success) in the Control Group P2 is the probability of a success in those clusters that are assigned to the
control group in each stratum of this set.

This report shows the values of the individual, strata-level parameters that were used. These parameters are the
same for all rows of the Numerical Results Report (shown above), so they are only displayed once.

Plots Section

The values from the Numerical Results report are displayed in this plot.
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Example 2 – Validation using Xu, Zhu, Ahn (2019)
Xu, Zhu, and Ahn (2019) provide an example of the power analysis of a stratified, cluster-randomized study. The
data are to be analyzed by a two-sided Cochran-Mantel-Haenszel test. We will use their results to validate this
procedure.
Their example had four strata with 4419, 4738, 4175, and 1093 subjects per stratum. (We will enter these
numbers directly and let the program rescale them to percentages.)
The probability of success was 0.14 in each stratum. The average number of patients per cluster were 177, 119,
84, and 122. The corresponding standard deviations were 75, 53, 36, and 58.
The value of ICC was 0.015. The significance level is set to 0.05 and the power is set to 0.8. The odds ratio is set
to 0.75923. They obtained a total sample size of 12387.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load this procedure. You may then make the appropriate entries as listed below, or open Example 2 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For .................................................................. Sample Size
Alternative Hypothesis .............................................. Two-Sided (H1: OR ≠ 1)
Power ........................................................................ 0.8
Alpha ......................................................................... 0.05
OR (Actual Odds Ratio) ............................................ 0.75923
ICC (Intracluster Correlation) .................................... 0.015
Cluster Size Variation Input ...................................... Standard Deviation
Set 1 Number of Strata ............................................. 1
Set 1 Percent of N in Each Stratum .......................... 4419
Set 1 Average of Cluster Sizes ................................. 177
Set 1 Standard Deviation of Cluster Sizes ............... 75
Set 1 Pr(Success) in the Control Group (P2) ........... 0.14
Set 2 Number of Strata ............................................. 1
Set 2 Percent of N in Each Stratum .......................... 4738
Set 2 Average of Cluster Sizes ................................. 119
Set 2 Standard Deviation of Cluster Sizes ............... 53
Set 2 Pr(Success) in the Control Group (P2) ........... 0.14
Set 3 Number of Strata ............................................. 1
Set 3 Percent of N in Each Stratum .......................... 4175
Set 3 Average of Cluster Sizes ................................. 84
Set 3 Standard Deviation of Cluster Sizes ............... 36
Set 3 Pr(Success) in the Control Group (P2) ........... 0.14

242-10
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for Two Proportions in a Stratified Cluster-Randomized Design (Cochran-Mantel-Haenszel Test)
Set 4 Number of Strata ............................................. 1
Set 4 Percent of N in Each Stratum .......................... 1093
Set 4 Average of Cluster Sizes ................................. 122
Set 4 Standard Deviation of Cluster Sizes ............... 58
Set 4 Pr(Success) in the Control Group (P2) ........... 0.14
Set 5 Number of Strata ............................................. 0
Show More Strata Sets ............................................. Unchecked

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results with Continuity Correction
Numeric Results of the Cochran-Mantel-Haenszel Test ───────────────────────────────────
Hypotheses:
H0: OR = 1 vs. H1: OR ≠ 1
Number of Strata:
4

Power
0.8000

Total
Sample
Size
N
12387

Anticipated
Treatment
Number of
Actual Probability
Clusters Odds Ratio of Success
M
OR
P1
106.0
0.7592
0.1100

Control
Probability
of Success
P2
0.1400

Intracluster
Correlation
Coefficent
ICC
0.0150

Alpha
0.050

Strata-Detail Report ──────────────────────────────────────────────────────────

Set
1
2
3
4

Number
of Strata
1
1
1
1

Percent of
N in Each
Stratum
30.63
32.85
28.94
7.58

Average
of Cluster
Sizes
177.0
119.0
84.0
122.0

Standard
Deviation
of Cluster
Sizes
75.00
53.00
36.00
58.00

Coefficient
Pr(Success)
of Variation in the Control
of Cluster
Group
Sizes
P2
0.4237
0.1400
0.4454
0.1400
0.4286
0.1400
0.4754
0.1400

PASS has also obtained a sample size of 12387, which validates this procedure.
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